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Library Website 
 

library.dgist.ac.kr 

 
Library's Google-like search engine that provides fast, 

relevancy-ranked results through a single search box. 
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 DGIST 
Library 

DGIST Library provides access to a vast range of electronic resources(e-

resources) to support your studies, research, and teaching. 

 

 Student Portal(MyDGIST)> Service Link> Library 

 https://library.dgist.ac.kr 

 e-Resources 
Use Policy 

Use of the e-resources is subject to copyright law, and the license agreements 

that DGIST Library signs with the e-resource providers - please make sure you 

read the e-resources use policy here(Library Website> Online Resources> 

Electronic Resource Use Policy). 

 Access to 
e-Resources 

In general, e-Resources are available to all users on site at DGIST, with off-site 

access limited to DGIST members only. 

 

Off-Campus Access to e-Resources 

 Access via the Library Website: Run a search using the main search box 

on the Library homepage. You will be prompted to log in using your DGIST 

ID before accessing a licensed online resource. 

 Library Proxy Server: The library proxy server provides off-campus or 

remote access to subscription resources. 

Prepend http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/ to the resource URL. 

 Search      
& Find 

Article Search is a search tool for finding journals, books, full-text articles, etc. 

 

1. Enter the search terms into the ‘E-RESOURCE’ search box at the center of 

the Library website main page; you can select Advanced Search options 

from the results page. 

2. Refine results by date, subject, academic journals, and other options. 

3. View results, and link directly to full text or more details. 

 

* (tip) You can request an article or book you need if it is not subscribed online 

by DGIST Library, and we will try to obtain it for you from another library.  

Library Website > Service Request > Document Delivery Service 

 Browse by     
A to Z  

 

DGIST library subscribes to various science and technology journals, but not all 

journals, so you should check whether you subscribe to them on the library 

website. 

 Library Website > Online Resources > Databases / e-Journals / e-Books 

https://library.dgist.ac.kr/
https://library.dgist.ac.kr/eData/eResourceRulesOfUse.do
http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/
https://library.dgist.ac.kr/libService/DDSReqst/article/direct.do?ddsMtrilSe=1
https://library.dgist.ac.kr/eData/webdb.do
https://library.dgist.ac.kr/search/eJrnl.do
https://library.dgist.ac.kr/search/eBook.do
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 Library Web at a Glance 
 

 

  

① Login 

② Navigation 

③ Search Box 

 - (COLLECTION) Search the library catalog 

 - (E-RESOURCE) e-Resources discovery search 

 - (STAR LIBRARY) Federated search DGIST- 

KAIST-GIST-UNIST library resources 

④ Overview(Loans&Reservations) 

⑤ Quick Services 

⑥ New Arrivals 

 -  Most recently acquired materials. 

 

 

 

⑦ Follow Us 

 - Preview posts uploaded to library social media 

 

 

 

 

 

 

 

 

⑧ LibChat 

- Chat with the librarians. Chat service is 

available 

when librarians are on duty.  
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Web of Science 
Global citation database 

 
The World’s Most Trusted Citation Index 

Covering the Leading Scholarly Literature 
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 About What is Web of Science? 

Web of Science Core Collection provides cover-to-cover indexing back to 1900 across 

the world’s highest-quality and most impactful publications. Web of Science provides 

access to bibliographic information, author abstracts, and cited references from 

scholarly journals and conference proceedings. A cited reference search enables you to 

find articles that cite a previously published work. 

 

Accessing the Web of Science 

(On-Campus: IP range) http://webofscience.com  

(Off-Campus) Library Website > Online Resources > Databases or via proxy server: 

http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/http://webofscience.com 

 WoS Core 
Collection 

Web of Science Core Collection is our premier resource on the Web of Science platform 

and the world’s original citation index for scientific and scholarly research. A curated 

collection, Web of Science Core Collection contains over 21,100 peer-reviewed, high-

quality scholarly journals published worldwide (including Open Access journals) in over 

250 sciences, social sciences, and arts & humanities disciplines. Conference proceedings 

and book data are also available. 

 

SCIE(Science Citation Index Expanded) 

Created as SCI in 1964, Science Citation Index Expanded™ now indexes over 9,500 of 

the world’s most impactful journals across 178 scientific disciplines. More than 53 

million records and 1.18 billion cited references date back from 1900 to present. 

 Search Go to Web of Science. And you can see a search box in the middle of the page. To 

make use of the specific features of each resource you should go directly to that 

resource by clicking on the arrow and selecting it from the drop-down menu. In most 

cases, the Core Collection is the best option. 

 

 (Topic Search) If you select the Topic, you can get more accurate results. A 

search by topic will search in the title, abstract, and keyword fields of Web of 

Science records. 

 (Author Search) Enter author names in the format shown in the examples in the 

search boxes. Web of Science will attempt to auto-complete names based on its 

records. If you know the ResearcherID, enter this directly. 

 (Search Tools) Operators such as AND, OR, NOT, NEAR, etc. can provide more 

accurate search results. 

 Search 
Results 

Refine your results 

Focus your search to find top Subject Categories, Publication years and more. Once 

you have a list of results, you can use the limits options available in the Refine Results 

http://webofscience.com/
http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/http:/webofscience.com
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bar to the left of the screen to add additional terms to your search or to restrict your 

search by subject area, document type, publication date, language, etc. 

 

Analyze Results 

 Use Analyze Results to group and rank records in a result set by extracting data values 

from a variety of fields. Find the most prevalent authors in a particular field of study or 

generate a list of institutions ranked by record count based on your search query. 

 

Create a Citation Report 

The Citation Report feature provides opportunities for advanced citation tracing by 

analyzing Citing Articles and Times Cited. To get a citation report, click on Citation 

Report on the right of the search box. If the number of articles exceeds 10,000, the 

Citation Report button will not be available. 

 
© 2021 Clarivate. Clarivate and its logo, as well as all other trademarks used herein are 

trademarks of their respective owners and used under license. 
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 Viewing a 
Full 
Record 

 
 

 

Click on the title of an article to view the full record, including the cited references, 

abstract, DOI* and other information. 

 

 If you set up the 'Create Citation Alert' service for your paper, you will be notified 

by email and RSS when someone cites your article as a reference and publishes it 

in the SCIE journal. 

 Web of Science does not provide full text. However, by clicking 'Full-Text 

Options' on the screen, you can go to the publisher's homepage or PubMed to 

read the original text. If the library is not subscribing to the paper, you can 

go to Google Scholar and look for other original versions, such as Preprint. 

 

* (tip) DOI (Digital Object Identifier) is a permanent, stable online link to a specific 

item. It is more stable than a URL, as URLs can change, for example, if an 

organization restructures its website. 

 For More 
Information 

 
 

 

You can refer to FAQs, QnA, and educational materials by clicking the '?' button at the 

bottom right of the screen. Clarivate also provides a self-guided course for users. 

 

 Training Resources   https://clarivate.com/webofsciencegroup/support/wos/ 

 Video Tutorials   https://videos.webofsciencegroup.com/ 

 

  

https://clarivate.com/webofsciencegroup/support/wos/
https://videos.webofsciencegroup.com/
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Scopus 
Expertly curated abstract & citation database 
 

 

Discover the most reliable, relevant, up-to-date research. 



        

12 

 About What is Scopus? 

Scopus is a source-neutral abstract and citation database curated by independent 

subject matter experts who are recognized leaders in their fields. Scopus puts powerful 

discovery and analytics tools in the hands of researchers, librarians, research managers, 

and funders to promote ideas, people, and institutions. Scopus is not a database that 

provides full-text articles but provides links to access library subscription resources or 

Open Access materials. 

 
© 2022, Elsevier. (https://www.elsevier.com/solutions/scopus) 

 

* (tip) What is a citation database?  A citation gives credit to a source and contains 

publication information such as author(s), title, and date. Most Scopus citations link 

to the full-text version of the publication hosted on various publishers' platforms. 

 

Accessing the Scopus 

 

(On-Campus: IP range) https://www.scopus.com  

(Off-Campus) Library Website > Online Resources > Databases or via proxy server: 

http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/https//www.scopus.com  

 Search 
& Analyze 

In Scopus, you can search by Documents, Authors, or Affiliations. When you first 

access Scopus, by default it is set to carry out a 'Document' search, which will retrieve 

records containing your search terms in the fields that you specify. You should use this 

option if you wish to retrieve records for publications on a particular topic, or that meet 

other search criteria. 

You can also choose to search for 'Authors' or 'Affiliations'. These options are useful if 

you would like to see a breakdown of publications by a particular author or organization, 

and other data relating to their publications. 

 

* (tip) Look for 'Search History' at the bottom of the screen. Your search history is 

shown bottom of the screen with the options to create RSS feeds and alerts, and 

save, edit or delete queries. Combine queries from your history by entering the listed 

search number with Boolean operators. 

 

https://www.scopus.com/
http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/https/www.scopus.com


        

13 

 Documents Search 

Documents include journal articles, book chapters, conference proceedings, articles in 

press, and data papers. 

 
[A] Enter your search terms into the search documents box. [B] You can specify in 

which fields to search using the drop-down menu. [C] Use the '+Add search field' option 

to add additional fields. Each new search field is combined using the Boolean operators 

AND, OR, and NOT. [D] To see a complete list of advanced field codes, select Advanced 

document search. 

 
 [A] On a search results page, the options ‘Edit’, ‘Save’, ‘Set alert’ and ‘Set feed’ are 

available for the query. [B] Sort results by date (default option), cited by, relevance, 

first author name or source title. [C] These options allow batch processing of all or 

selected results: export; download as PDF; view citation overview; view citing 

documents; save to temporary list; view references; bibliography; print; or send results 

as an email. [D] Click 'View abstract' to display the abstract.  opens the 

full text on the publisher website, if authorized. Related documents displays referenced 

works. 

* (tip) Analyze Search Results and View Citation Overview Clicking Analyze 

search results on a search results page shows the number of documents in your 

search results broken down by year, source, author, affiliation, country, document 

type and subject area. 

 

 

A B 

C D 

A 

B 

C 

D 

tip 
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Author Search 

When you search by authors, you can search by last and/or the first name. You also 

have the option to search by ORCID ID. 

 
By searching the author's name or ID, you can check the author's profile, the number 

of papers, and research results such as Citations and h-index. Click a name in the result 

list to open the Author profile. 

 
[A] Use 'Set alert' to receive alerts about new publications. Click 'Potential author 

matches' to view and group together authors with similar profiles. [B] Click 'View h-

Graph' to display the h-index as a graph. Click 'Analyze author output' to visualize their 

output as graphs. 'Citation overview' analyzes citations of their articles by publication 

year. [C] You can create an email alert to be notified when Scopus publishes new 

documents by an author. [D] Click ‘Export all’ to export an author’s document 

information to a selected file type or reference management tool such as EndNote, 

Mendeley, etc. 

 

Affiliations Search 

 
When you search by affiliation, just type the affiliation's name. The search will begin 

to auto-populate. 'Affiliations Search' is mainly used with interest by research 

A 

B 

C 

D 

A 
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performance managers and executives. Still, researchers can also use it to understand 

the current status of institutions when studying abroad or thinking about career paths. 

 Browsing 
for Sources 

 Use the ‘Sources’ page to browse the list of all journals, book series, trade publications 

and conference proceedings available on Scopus. You can search by title, subject area, 

publisher or ISSN. 

 For More 
Information 

Click the '?' button in the upper right corner of the Scopus website for FAQs, QnA, and 

training. 

 

 Support Center   https://service.elsevier.com/app/overview/scopus/  

 Webinars   https://blog.scopus.com/webinars  

 LibGuides   https://elsevier.libguides.com/Scopus  

https://service.elsevier.com/app/overview/scopus/
https://blog.scopus.com/webinars
https://elsevier.libguides.com/Scopus
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ScienceDirect 
 

Search for peer-reviewed journal articles and book chapters (including open access content) 
 

 

About ScienceDirect 

 

ScienceDirect has electronic resources published by Elsevier, one of the world's leading STM publishers. It 

includes about 2,700 subscribed journals and purchased e-books by the library. ScienceDirect provides the 

full text of the paper in PDF or HTML format, unlike Scopus, which provides only citation index information 

and links to the full-text articles. 

 

Access to ScienceDirect 

 

(On-Campus: IP range) https://www.sciencedirect.com/  

(Off-Campus) Library Website > Online Resources > Databases > ‘ScienceDirect’ 

or via proxy server: http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/https://www.sciencedirect.com/  

* (tip) The user experiences continued access for up to 48 hours after leaving the institution's IP 
address range(s) as long as: The user works from the same device and browser and cookies are 
enabled. 

 

Useful Services 

 

 My Recommendations 

On the home page, click on your name and then ''My recommendations''. The Recommendations service 

finds research on ScienceDirect that is directly related to the content you've recently viewed on the platform 

while signed in. These suggestions are then emailed to you on a weekly basis, or you can view a list of 

recommended articles on ScienceDirect. 

Often, these recommendations are for research you may not have previously considered, opening the door 

to new paths of inquiry and collaboration. 

 Browse Topics 

 In addition to searching and browsing, you can also discover foundational content with ScienceDirect 

Topics, a popular feature for researchers and students looking to broaden their understanding of scholarly 

and technical terms. To access a topic page: 

- From a ScienceDirect article, chapter, or topic page, select the hyperlinked term to open the relevant 

topic page. 

- Find your topic on the Topics index Page: https://www.sciencedirect.com/topics/index  

 

 

https://www.sciencedirect.com/
http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/https:/www.sciencedirect.com/
https://www.sciencedirect.com/topics/index
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  Google Scholar 
Stand on the shoulders of giants. 
 
 
Search all scholarly literature from one convenient place 
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 About What is Google Scholar? 

Google Scholar is a search engine that provides links to full-text articles to which the 

University Library System subscribes or to articles made freely available by the 

publisher. From one place, you can search across many disciplines and sources: articles, 

theses, books, abstracts and court opinions, from academic publishers, professional 

societies, online repositories, universities and other websites. 

However, Google is also less careful in what it includes in search results than in more 

curated subscription-based academic databases such as Scopus and Web of Science -  

results can consist of unscholarly documents and articles from predatory journals. So 

it is worth assessing the credibility of the linked resources through Google Scholar. 

 

Access   https://scholar.google.com/  

 Pros & 
Cons 

Pros of Google Scholar 

- Fast and easy to use, so you may find it easier to get started 

- Supports searching in any language 

- Search vast array of information 

- Searches a wide range of scholarly outputs 

 

Cons of Google Scholar 

- Coverage is incomplete and variable across disciplines 

- Includes results you won't have access to 

- Cannot do backward citation tracking 

- Not everything in Google Scholar is scholarly – results can include unscholarly 

documents as well as articles from predatory journals 

 

Library databases provide a more efficient and effective means to access information. 

Make good use of your library database to compensate for Google Scholar's 

weaknesses. Go to the library website(library.dgist.ac.kr) and enter your search term 

in the 'E-RESOURCE' search box on the main page. 

 Connect to 
Library 

Adding library link 

You can set up Google Scholar to display "Find it @ DGIST" links to your search results. 

The "Find it @ DGIST" links in Google Scholar allow you to access the full text of sources 

through the Library subscriptions or request sources through the Interlibrary Loan 

service.

 

https://scholar.google.com/
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1. Go to Settings at the top of the Google Scholar search screen, then select 

Library links. 

2. Search for DGIST and select the “Daegu Gyeongbuk Inst Sci Tech – Find it @ 

DGIST” checkbox. 

3. Make sure this box is checked and click Save. 

 Search Since searching in Google Scholar is as straightforward as searching in Google, it's 

best to jump right in and try it. 

 
 

Advanced Search 

 
You will have to navigate to the three horizontal lines on the left side of the screen to 

access Google Scholar's advanced search features. By clicking on the "advanced search" 

link, a box will pop up with many options that will allow you to refine your search. This 

advanced search will allow you to sort by specific phrases, authors, and date ranges. 
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Search Results 

Let's have a look at the results. 

 
[A] The first two lines of each result provide the document's title. The second line 

provides the bibliographic information about the document in order: the author(s), the 

journal or book it appears in, the year of publication, and the publisher. [B] Sometimes, 

there will be a PDF or HTML link to the right of a document's title on the search results 

page. Clicking on that link should take you to the full text of the paper. [C] Below the 

abstract, you can find some useful links. The first of these is the Cited by link will show 

other articles that have cited this resource. It is an excellent way to track the more 

recent research that has referenced this article, and other researchers who cited this 

document lend greater credibility to it. [D] The Versions link will display other versions 

of the article or other databases, some of which may offer free access to the article. 

 

Search Tips 

Although Google Scholar limits each search to a maximum of 1,000 results, it's still 

too much to explore, and you need an effective way of locating the relevant articles. 

 Use only the important words rather than a full sentence or question. Too many 

words will limit your results. 

 Use double quotation marks for exact phrases. Only use this if you're looking 

for a very precise word or phrase, because otherwise you could be excluding 

helpful results by mistake. 

 Place a negative sign (-) in front of words you wish to be excluded from your 

search. 

 Add the year to the search phrase to get articles published in a particular year. 

Use the filters in the left sidebar. You can restrict the search results and sort by 

relevance or date. 

 For More 
Information 

 Google Scholar Help   https://scholar.google.com/intl/en/scholar/help.html  

 LibGuides   https://libguides.dgist.ac.kr/google 

  

A 
B 

C D 

https://scholar.google.com/intl/en/scholar/help.html#export
https://scholar.google.com/intl/en/scholar/help.html
https://libguides.dgist.ac.kr/google
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JCR (Journal Citation Reports) 
The world's leading journals and publisher-neutral data 

 

 

Support responsible research evaluation with JCR 
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 About JCR What is JCR? 

Journal Citation Reports (JCR) offers a systematic, objective means to critically 

evaluate the world's leading journals with quantifiable, statistical information based on 

citation data. By compiling articles' cited references, JCR Web helps measure research 

influence and impact at the journal and category levels and shows the relationship 

between citing and cited journals. Statistics over the past 1-2 years are updated around 

June. 

 

Accessing the JCR 

(On-Campus: IP range) https://jcr.clarivate.com/ 

(Off-Campus) Library Website > Online Resources > Databases or via proxy server: 

http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/https://jcr.clarivate.com/  

 

 
© Clarivate (https://jcr.help.clarivate.com) 

 Journal 
Impact 
Factor 

Journal Impact Factor (JIF) 

The Journal Impact Factor (JIF) is defined as citations to the journal in the JCR year to 

items published in the previous two years, divided by the total number of scholarly 

items, also known as citable items, (these comprise articles and reviews) published in 

the journal in the previous two years. The JCR year is the last complete year within that 

year’s JCR data set. For example, the JCR year for the 2021 release is 2020. The JIF is 

updated around June every year. 

 

Journal Impact Factor is calculated using the following metrics: 

 

https://jcr.clarivate.com/
http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/https:/jcr.clarivate.com/
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 Browse   
& Search 

Browse Journals 

The browse journals page by default lists the top 25 journals by 2020 Journal Impact 

Factor. To find a specific title and view its profile, use the full search bar for journal 

name, ISSN, eISSN, category or keyword. 

The browse journal table has customizable indicators divided into four categories for 

ease of use: 

 Impact Metrics - metrics focused on the citation impact of the journals 

 Normalized Metrics - metrics that have been adjusted mathematically to allow wide 

comparisons 

 Source Metrics - metrics based on the content of the journals and used as the 

basis for the Journal Citation Reports 

The Browse Journals table can also be extensively filtered on several criteria using the 

dynamic filter option. Any applied filters are identified by the green dot next to the filter 

name. The top 400 items (as sorted) can be downloaded by clicking the Export option 

in a CSV format. For more extensive data or integration need, consider using the WoS 

Journals API which provides programmatic access to JCR data. 

 

© Clarivate (https://jcr.help.clarivate.com) 

 

Browse Categories 

To help facilitate discovery, you can now browse categories by Groups. The numbers 

vary by subject area, so impact factors shouldn't be used to compare journals in 

different fields. For example, the journal with the highest impact factor in the category 

Applied Physics (2020) was ‘NATURE MATERIALS’ with an impact factor of 43.841; the 

journal with the highest impact factor in the category Aerospace Engineering (2020) 

was ‘PROGRESS IN AEROSPACE SCIENCES’ with an impact factor of 8.653. 

 

(’22 New) Browse Publishers 

The new Browse Publishers feature allows you to search for or browse by publisher to 

see how many journals are covered in the most recent year. 
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 For More 
Information 

Click the '?' button in the lower right corner of the JCR website for FAQs, QnA, and 

training. 

 

 Support Center   https://clarivate.com/webofsciencegroup/support/support-jcr/  

 Webinars   https://bit.ly/3u6dpf0  

  

https://clarivate.com/webofsciencegroup/support/support-jcr/
https://bit.ly/3u6dpf0
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EndNote20 
A Smarter Way to Research 

 

Leave behind the tedious work of formatting bibliographies, 

finding full text, and searching for references. 
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 About 
EndNote 

What is EndNote? 

 EndNote is a reference manager that helps you save time formatting citations, so you 

can focus on your research. 

 

EndNote is reference management software with features to – 

 Keep all your references and reference-related materials in a searchable personal 

library. 

 Synchronize your references between up to three of your personal computers, an 

online library, and your iPad or iPhone through EndNote Sync. (You must be the 

owner and user of all three computers.) 

 Set up a library sharing team and effortlessly collaborate with up to 400 co-authors 

and colleagues. 

 Cite your references in word processing documents to create formatted citations 

and bibliographies or independent reference lists. 

 Installation Downloading and installing EndNote Desktop 

1. Go to the student portal(https://my.dgist.ac.kr) 

2. Go to the student bulletin > Notice > Academic Notice 

3. Search for 'endnote' in the search box and click on the post titled '[DGIST LIBRARY] 

EndNote 20 Install Guide'. 

- (Windows) Please read the notice and download the attached file. Make sure to 

unzip the file first and then run it. The 'License.dat' file and the 'EN20Inst.msi' 

file must be in the same folder to automatically authenticate the license. 

- (Mac) Download the file via the hyperlink in the notice. 

 Creating 
library(.enl) 

Creating, saving and opening a new EndNote Desktop library 

The first step of using EndNote is to create an EndNote Library. Open the EndNote 

Desktop program. And create a new EndNote Desktop library (File > New) and save it 

to your preferred location. This will create an .enl file and a .data folder -- both must 

kept together in the same location for your EndNote Library to work properly. If you 

move the .enl file to a different location, you MUST move the .data folder with it. 

 
* (tip) You should only make ONE Library. You can save up to 100,000 references 

in an EndNote library so that it will be big enough. Don’t make separate libraries for 

different assignments, etc., as this may lead to conflicts when you start using it 

with Word. 

        

       

          

        

          

 

      
 

      
 

https://my.dgist.ac.kr/
https://ecm.dgist.ac.kr/s/potal_board/_0014/listBbs.do


        

27 

 Library 
Overview 

Layout 

 
© 2022 Clarivate. 

 Adding 
References 

Most databases have a direct export feature that automatically transfers your search 

results into your EndNote library. Every database is different but look for links or buttons 

within the database that says 'export', 'EndNote', 'send to', or ‘RIS Format'. For some 

items, you will need to manually enter the information into your EndNote library.  

 

Exporting from Google Scholar 

1. Go to https://scholar.google.com  

2. Click on the 3 line menu at the top left and ‘Settings’ 

3. Under Bibliography Manager, click next to ‘Show links to import citations into’ and 

select EndNote from the Dropdown box. 

4. Click Save. 

 

        

       

          

        

          

 

      
 

https://scholar.google.com/
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Adding References Manually 

 You'll often enjoy automatically capturing new references in your EndNote library 

without manually populating the information. You also have the option to manually 

create an entry in your library for any reference materials you can't capture. 

Create a new entry manually by clicking References > New Reference (Ctrl+N) with 

your EndNote library open. 

 
© 2022 Clarivate. 

 

Importing PDF files 

PDF documents can be imported into EndNote. If the reference is already in your 

library, the PDF will be attached to that reference. If not, a new reference will be 

created, and the PDF attached. 

1. Open your EndNote library. 

2. Go to 'File' and select 'Import'. 

3. Choose 'File'. 

4. Click the 'Choose...'  button and navigate to, and select, the required file. 

5. Set Import Option to 'PDF', and Duplicates to 'Import All'. 

6. Click 'Import’. 

7. The reference is placed in a temporary group called 'Imported References'. 

 

* (tip) You can set your preferences in EndNote to enable the automatic importing 

of PDFs from a designated folder on your computer. When a PDF file is saved in 

the folder, it is automatically brought into EndNote to create a reference. 
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1.  Go to Edit > Preference > PDF handling > PDF Auto Import Folder. 

2.  Select ‘Enable automatic importing’. 

3.  Click ‘Select Folder’, navigate to, and then select the required folder. 

 Organizing 
References 

Making Groups to Organize Your References 

 Create Groups in EndNote to organize your references without creating multiple 

libraries. 

 Create a Group: On the EndNote toolbar, select Groups > Create Group and enter 

a Name for a group. Highlight references you want to add to the group (use the 

Ctrl or Shift key to select multiple references. Select Groups > Add References to 

> Group name or drag and drop references into the group. 

 Create Group Sets to organize your numerous groups: Select Groups > 

Create Group Set. To add existing groups to the group set, just left click on a group 

and drag to the group set. 

 Create Smart Groups: 'Smart groups' use search criteria to update groups as 

existing records are edited dynamically, or new records are added to the Library. 

Once a smart group is created, it works in the background, automatically adding 

new records that match the smart group's criteria. 

 Managing 
References 

Find Duplicates 

If you import references from more than one set of results, sometimes duplicate 

references will be in your library. To identify and delete duplicate records, select ‘Library’ 

on the toolbar, and click ‘Find Duplicates’. Click Keep this Record for the version 

required. The other reference will be removed. Check via Preferences (Edit > 

Preferences > Duplicates) the criteria for deduplicating.  
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 Finding 
Full-text 

'Find Full Text' is a function that matches DOI information, Web of Science URL, and 

PubMed ID to the collected references to find and automatically attach available PDFs. 

Select the references in your library that you want to find the full text. Right-click and 

select ‘Find Full Text’. Under the Library Electronic Resource Use Policy (Library website 

> Online resources), download less than 30 full texts per day from the same publisher. 

 

 Cite While 
You Write 
(CWYW) 

What is CWYW? 

 ‘Cite While Your Write(CWYW)’ is a tool that inserts your EndNote references in a 

Microsoft Word document. In order to use CWYW, you must have Word installed first in 

your computer before you install EndNote. DGIST students can access Microsoft Office 

365 (easyit.dgist.ac.kr > Software > Microsoft Office 365). After EndNote is installed, 

the EndNote tab will be displayed in Word. 

 
 

Inserting Citation 

 Select the ‘Output Style’ of the journal you want to submit first in Word or EndNote. 

Position your cursor within your body of text where you'd like to add a citation and then 

press the 'Insert Citation' shortcut found on the EndNote 20 tab in Microsoft Word. 

* (Output Style) It is a template that tells EndNote how to format the citations in 

a manuscript or bibliography. The most commonly used output styles are already 

included in the EndNote 20 download software. You can view these styles on Tools 

> Output Styles. In Word, go to EndNote20 tab > Style dropdown. Some styles in 

EndNote may require editing to display correctly in your document. If EndNote 

doesn't have the style you want, check out the website. (EndNote toolbar ‘Help’ > 

‘EndNote Output Styles’) 

https://library.dgist.ac.kr/eData/eResourceRulesOfUse.do
https://easyit.dgist.ac.kr/s/easyit/_0151/sub.do
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© 2022 Clarivate. 

 

Deleting Citations 

 (Important) Once you have inserted a citation, you should not edit it directly. If you 

make any changes within the brackets of a citation, it will disappear when the 

bibliography reformats. Instead, you must use ‘Edit & Manage Citation(s)’ on the 

EndNote20 tab in Word. 

 
 

Converting Citations to plain text 

 If you have completed writing your thesis, you must run the 'Convert to Plain Text' 

function before submitting it. Because the other person may not have the same version 

of EndNote, and thus the field codes may not work correctly. To convert your citations 

to plain text, click ‘Convert Citations and Bibliography’ and save the document. It is 

recommended to back up in advance because you may post your paper again later in 

another journal. 
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 Syncing & 
Sharing 

Library Syncing in EndNote 20 

 Try the 'sync' service if you want to use EndNote on multiple devices. 

1. Start configuring library syncing by opening the EndNote library you’d like to 

designate as your EndNote Sync library and then click Library > Sync. 

2. Click Sign Up to create a new EndNote account or sync with an existing account by 

inputting your login credentials. 

3. Every 15 minutes, EndNote will check your library to look for changes to send or 

receive. Click Sync Status to confirm EndNote is synchronizing all reference 

information between your desktop library and your online account. 

4. To sync on a second or third computer, create a fresh EndNote library by choosing 

File > New. Click Library > Sync to input your EndNote account credentials and 

perform your initial sync to copy down all existing library information. 

 

Library Sharing in EndNote 20 

 Collaboration is essential to your research. The library sharing feature in EndNote 20 

allows you to grant access to your designated Sync library by setting up a sharing team 

with up to 400 other EndNote desktop users. After configuring EndNote Sync, open your 

designated Sync library and click File > Share to configure your sharing team. 

 
© 2022 Clarivate. 
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 For More 
Information 

On the EndNote toolbar, select ‘Help’. Technical support, output format, recent 

updates, community, knowledge base, and more. 

(Search Knowledge Base) 

You can search or browse frequently asked 

questions. 

(EndNote Training Portal) 

Many training options include video tutorials, self-

guided learning, and webinars. 

(EndNote Online) 

EndNote Online has less functionality than the 

desktop product, but it's free and web-based, so you 

can access your records from anywhere. 
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Mendeley 
Your new reference manager 

 

Mendeley brings your research to life, 

so you can make an impact on tomorrow 
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 About 
Mendeley 

What is Mendeley? 

 Mendeley Reference Manager is a free web and desktop reference management 

application. It helps you simplify your reference management workflow so you can focus 

on achieving your goals. 

 

 With Mendeley Reference Manager you can: 

 Store, organize and search all your references from just one library. 

 Seamlessly insert references and bibliographies into your Microsoft® Word 

documents using ‘Mendeley Cite’. 

 Read, highlight and annotate PDFs, and keep all your thoughts across multiple 

documents in one place. 

 Collaborate with others by sharing references and ideas. 

 Benefits  DGIST Library has subscribed the access to Mendeley Institutional Edition which offers 

you the following extra benefits in comparison with the free version: 

 100 GB personal storage instead of 2 GB with the 'free account' 

 100 GB shared storage instead of 100 MB with the 'free account' 

 Unlimited private groups of up to 100 collaborators instead of 5 private groups of 

up to 25 collaborators 

 Accessing Access to Mendeley Institutional Edition 

1. Go to https://www.mendeley.com 

2. Sign into your Mendeley account or create a Mendeley account using your 

DGIST email address (@dgist.ac.kr). You are automatically authenticated as 

a DGIST member when you log in on campus. 

3. You should then receive an email that confirms your account has been 

upgraded. 

4. Check at https://www.mendeley.com/settings/subscription that your account 

is Mendeley Institutional Edition (MIE) 

 
 

Desktop Application 

 Mendeley has both a web (browser-based) version and a desktop application. If you 

want to make the most of Mendeley, it's best to use both. 

 Download: https://www.mendeley.com/reference-management 

        

       

          

        

          

 

      
 

https://www.mendeley.com/
https://www.mendeley.com/settings/subscription
https://www.mendeley.com/reference-management


        

36 

Syncing Your Accounts 

 Syncing your Mendeley web account with Mendeley Reference Manager will allow you 

to access your citation library in multiple locations. If you want the desktop application 

installed on more than one computer, syncing through the Mendeley Web account will 

keep the information up-to-date on all your machines. The sync button is located in the 

upper-righthand corner, next to your account name. 

 

 Adding 
References 

Web Importer (ToolBar) 

 If you use 'Mendeley Web Importer', you can save references directly from the website. 

Download the browser extension Mendeley Web Importer to your browser. The browser 

extension works with Chrome, and Firefox. When the extension is added, you see it in 

the upper bar of your browser. 

 

Importing References from most common databases 

It is best compatible with Scopus and ScienceDirect, another database of Elsevier, a 

publisher that provides Mendeley. After selecting the desired paper from the search 

results, click 'Save to Mendeley' to add a reference to Mendeley. 

* (tip) In Google Scholar, references can be imported using 'Web Importer' or in RIS 

format (RefMan) via the 'Cite(")' feature.  

 
 

 

 

        

       

          

      
 

1 
2 
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Saving PDF files 

 Just drag and drop PDFs into the Mendeley Reference Manager window. Mendeley will 

automatically extract the metadata from the PDF(s) and create a library entry. 

 

Copyright © 2022 Mendeley Ltd. All rights reserved. 

 Reading & 
Annotating 
Documents 

Mendeley Reference Manager allows you to annotate and highlight PDFs that are 

uploaded into your Mendeley library. Don’t forget to click the sync icon at the top right 

of the screen when you are done reading, highlighting, and annotating. It will save your 

changes to the cloud so you can see them on any of your devices. 

 Mendeley 
Cite 

Mendeley Cite add-in for Microsoft Word allows you to easily insert references from 

your Mendeley library into your Word document, change your citation style and 

generate a bibliography - all without leaving your document. It is similar to 'CWYW' in 

EndNote. 

 Download: https://www.mendeley.com/reference-management/mendeley-cite  

 Collaborate Groups allow you to share the full text of PDF documents you add to the group. This 

allows other group members to look at exactly the same documents as you - useful 

when working together on a project. To create a group, click on ‘New Group’ under 

‘Private Groups’ in the left-hand pane. 

 For More 
Information 

Scroll down from mendeley.com to go to the support services and download pages. 

 Help Guides: https://www.mendeley.com/guides  

 Support Center: https://service.elsevier.com/app/home/supporthub/mendeley/  

  

https://www.mendeley.com/reference-management/mendeley-cite
https://www.mendeley.com/guides
https://service.elsevier.com/app/home/supporthub/mendeley/
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Finding Collaborators 
Making & Managing the Researcher Profiles 

 

How to promote my research achievement effectively. 
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 Informing 
Myself as a 
Researcher 

What is a Researcher Profile? 

Researcher profiles are kinds of social networks that display research results. It is 

used to identify individual researchers and collect research results on a single page to 

communicate with fellow researchers and promote the citing, recruitment, etc. Do you 

want to effectively publicize your research interests and achievements amid the flood 

of research literature? Start checking the record of your papers at researcher profiles 

in primary index DBs such as Web of Science, Scopus, and Google Scholar. In addition, 

it is good to sign up the popular services, such as ORCiD, ResearchGate, Linkedin, 

etc. 

 

How to Search and Make Researcher Profiles 

Web of Science and Scopus may have profiles created automatically based on 

publication information, so you should first browse your profile page. You can claim 

ownership after registering as a member if you already have a profile. For other sites, 

you can enter information directly after registering as a member. Suppose you are a 

researcher in the field of chemistry or biology. In that case, publishers often ask for 

ORCiD input while publishing a journal article, so check if you already have an ID. It 

is convenient to link ORCiD, Web of Science, and Scopus profiles. 

 

 Web of Science: https://www.webofscience.com/wos/author/search 

 Scopus: https://www.scopus.com/search/form.uri?display=basic#author  

 Google Scholar: https://scholar.google.co.kr/citations  

 ORCiD: https://orcid.org 

 ResearchGate: https://www.researchgate.net 

 Linkedin: https://linkedin.com  

 Using 
DRIMS 

Profiles in DGIST Research Performance Management System (DRIMS) 

 

Any graduate student, researcher, or professor affiliated with DGIST can manage 

their research achievements in DRIMS (https://rims.dgist.ac.kr), a system built and 

provided by the library. Enter your researcher profile IDs in [Researcher Info. - 

Researcher ID]. You can easily access your profile pages anytime by clicking on the 

profile badge under your name on the first page of DRIMS. 

https://www.webofscience.com/wos/author/search
https://www.scopus.com/search/form.uri?display=basic#author
https://scholar.google.co.kr/citations
https://orcid.org/
https://www.researchgate.net/
https://linkedin.com/
https://rims.dgist.ac.kr/
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DGIST Scholar 

Searching & Promoting the Research of DGIST 
 

Digital Repository of DGIST Research Information. 
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 Getting 
Started with 
DGIST Scholar 

 

Institutional Repository of DGIST 

DGIST Scholar is a repository and academic database of research performance 

information such as dissertations, journal articles, proceeding papers, and patents 

since the founding of DGIST. SCIE, Scopus, KCI registered academic papers, DGIST 

master's and doctoral dissertations, papers presented at major conferences, and 

patent information have been collected and updated weekly. If you are considering 

going to graduate school, you can check the news and achievements of various labs 

of DGIST at once.  

 

 Access URL https://scholar.dgist.ac.kr  

 

DGIST Scholar & Open Access 

Even if you don't publish your article in a fully Open Access journal, many publishers 

allow sharing the manuscript version before/after the peer review. So you can upload 

your pre/post-print to DGIST Scholar after checking the publisher's copyright policy. 

It can contribute to more publicity and dissemination of your research. 

 

Main Functions and Usage 

 Recent Additions, Top download: Search for the latest academic 

achievements and popular materials at DGIST 

 Communities & Collection: Explore significant academic achievements by 

DGIST departments and laboratories 

 Researchers: Browse information and performances of DGIST researchers 

 Check detailed information on DGIST academic literature and citation 

indexes such as SCIE and Scopus 

 Identification of documents and researchers matching the keywords, etc. 
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 Open Access 
& Self-
archiving 

Publishing in Open Access Journals 

Publishers usually own the copyright of papers. So even if you are an author, it is 

impossible to share them on your lab website. Not every researcher can get support 

from the library that has a subscription to as many journals as DGIST. If you want 

your papers to be read and cited by more researchers, you can consider publishing 

Open Access. However, OA publication is more expensive for authors because they 

have to pay the APC(Article Processing Charges). 

 

Share pre/post-prints on the DGIST Scholar 

However, some publishers allow sharing of preprints or post-prints so that you can 

archive them on the DGIST Scholar, personal website, or laboratory website following 

the copyright policy. 

 

 Open Access Journal List: https://doaj.org  

 Check the journal copyright policy: https://v2.sherpa.ac.uk/romeo 

 For More 
Information 

Library Libguides 

 

 DGIST Scholar: https://libguides.dgist.ac.kr/OpenAccess/DGISTScholar 

 OpenAccess@DGIST: https://libguides.dgist.ac.kr/OpenAccess 

 

https://doaj.org/
https://v2.sherpa.ac.uk/romeo/
https://libguides.dgist.ac.kr/OpenAccess/DGISTScholar
https://libguides.dgist.ac.kr/OpenAccess
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STAR Library 
Starlibrary.org 

 

A library cooperative network among DGIST, KAIST, GIST, UNIST 
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 STAR Library STAR Library is a cooperative network in which libraries of four science and 

technology specialized universities, DGIST, KAIST, GIST, and UNIST, share research 

information and resources. 

 

Access   https://starlibrary.org  

 

About Services 

 Search for and browse researchers, laboratories & research output of DGIST, 

KAIST, GIST, UNIST 

 Provide article analysis, citation statistics, and research collaboration 

information 

 Resource Sharing: Inter Library Loan, Document Delivery Service 

 

 
 

https://starlibrary.org/
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 Read & Publish 

No. Name Note 

1 
CUP(Cambridge University Press) 

Read & Publish 

('22 Upgrade) You can publish your article gold OA at no cost to 

you, or with a discount for your article processing charge (APC). 

You can also enjoy access to journals content from Cambridge 

University Press. 

2 
COB(Company of Biologists) 

Read & Publish 

('22 Upgrade) Read & Publish agreements offer unlimited “read” 

access to our five subscription journals - Development, Journal of 

Cell Science, Journal of Experimental Biology… – plus uncapped 

fee-free Open Access publishing of research articles. 

 

 Search Tools 

No. Name Note 

1 
JCR Web(Journal Citation 

Reports) 

Check Journal Impact Factor, and evaluate and compare journals 

using citation data 

2 MathSciNet 

Database managed by AMS (American Mathematical Society), 

including Mathematical Reviews and Current Mathematical 

Publication. 

3 S2Journal  

Search various indicators to evaluate a researcher's performance, 

provide journal recommendation service and check fake journals, 

offer other various and unique information about journals 

4 SciVal 

A solution to search, analyze, and compare research results of 

universities, institutions, and researchers around the world based 

on data indexed in Scopus. 

5 Scopus It is the largest citation abstract database published by Elsevier. 

6 Web of Science(SCIE, CPCI) 

('22 Upgrade) Access to bibliographic information, author abstracts, 

and cited references from scholarly journals and conference 

proceedings. 

 

  

[Appendix] List of Online Resources in DGIST Library for 2022 

 

This list can also be viewed on the library website. (About > News & Events) 

※ For details of each resource and user manual, refer to the library website.(Online Resources > Databases) 

 

https://www.cambridge.org/core/
https://www.cambridge.org/core/
https://journals.biologists.com/
https://journals.biologists.com/
https://jcr.clarivate.com/
https://jcr.clarivate.com/
https://www.ams.org/mathscinet
https://s2journal.bwise.kr/
https://www.scival.com/home
https://www.scopus.com/
https://www.webofscience.com/
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 Databases that provide the full-text of journals 

No. Name Note 

1 
AACR(American Association for 

Cancer Research) 

AACR Provides full-text of 9 journals published by the American 

Association for Cancer Research 

2 ACM Digital Library 

A comprehensive collection of full-text articles and bibliographic 

records in the fields of computing and information technology 

published by ACM 

3 
ACS(American Chemical Society) 

Publications 

Provides full-text of about 70 journals published by the 

ACS(American Chemical Society) 

4 
AIP(American Institute of 

Physics) Plus 

('22 Add 11 journals) It is the web portal, which provides e-

journals relating to AIP and other physics conferences. 

5 Annual Reviews 

('22 Add 4 journals) Available 51 journals in biomedicine, physics, 

social sciences, etc. published by Annual Reviews. 

6 APS(American Physical Society) 

Available about 15 research journals include Physical Review Series 

published by APS 

7 
APS(American Physiological 

Society) 

Database of full text from 15 journals 

8 
ASM(American Society for 

Microbiology) 

Provide journals in microbiology published by ASM(American 

Society for Microbiology) 

9 
ASME(American Society of 

Mechanical Engineers) 

Provide topics relating to the recent trend in mechanical 

engineering 

10 
ASPB(American Society of Plant 

Biologists) 

It was founded in 1924, and currently publishes two world-

renowned journals in botany and reference resources and books in 

the relevant area. 

11 Cell Press 

('22 Add 1 journal)  Available 16 primary journals in biomedical 

research published by Cell Press 

12 
CSHLP(Cold Spring Harbor 

Laboratory Press) 

Available 6 core journals in molecular biology published by Cold 

Spring Harbor Laboratory Press 

13 IEEE-IEL(IEEE Electronic Library)  

Full text documents of journals, proceedings and technical 

standards published by IEEE and its publishing partners. 

14 IOP(Institute Of Physics) 

Publishes key e-books and journals in physics published by the 

Institute of Physics, and provides information on the latest research 

and trends in physics, medicine, applied physics, nuclear physics, 

optics, and nuclear physics. 

15 IOS Press 

Provide about 90 titles in Computer Science, Mathematics, Medicine 

& Natural Science published by IOS Press 

16 
ISPG(Independent Scholarly 

Publishers Group) 

Journal package comprises 7 publishers including the American 

Society of Neuroradiology, providing 23 journals including the 

American Journal of Neuroradiology 

17 
J-STEJ(Japan Science & 

Technology Electronic Journal) 

A package of Japanese science and technology journals, providing 

the full-texts of articles 

https://aacrjournals.org/
https://aacrjournals.org/
https://dl.acm.org/
https://pubs.acs.org/
https://pubs.acs.org/
https://aip.scitation.org/
https://aip.scitation.org/
https://www.annualreviews.org/
https://journals.aps.org/
https://journals.physiology.org/
https://journals.physiology.org/
https://journals.asm.org/
https://journals.asm.org/
https://asmedigitalcollection.asme.org/
https://asmedigitalcollection.asme.org/
https://academic.oup.com/journals/
https://academic.oup.com/journals/
https://www.cell.com/
https://www.cshlpress.org/
https://www.cshlpress.org/
https://ieeexplore.ieee.org/
https://iopscience.iop.org/
https://content.iospress.com/
https://bit.ly/3JQ7gK4
https://bit.ly/3JQ7gK4
https://bit.ly/3q1g0oI
https://bit.ly/3q1g0oI
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18 JSTOR Archive 

Provide journals and archives in General Sciences(Most journals are 

accessible from Vol.1 / Art & Sciences I~IX, XII, Life Sciences) 

19 Karger Database of over 50 journals in medicine from Karger Publishers. 

20 Nature 

('22 Add 56 journals) Available all journals published by 

Nature.(about 96 journals) 

21 
OPTICA Publishing(구, OSA 

Publishing) 

Available about 24 journals and conference proceedings in optics 

and photonics published by OPTICA Publishing 

22 OUP(Oxford University Press) 

Oxford University Press is the world's largest university publisher 

with a long history that began in 1478, covering all subjects 

including life sciences, medicine, humanities, and social sciences, 

law, and providing about 350 original texts in journals. 

23 
PNAS(Proceedings of National 

Academic of Science) 

Proceedings of the National Academy of Sciences and provides 

peer-reviewed scientific journals. 

24 PsycARTICLE(ProQuest) 

This database offers full-text articles for journals published by the 

American Psychological Association, the APA Educational Publishing 

Foundation, the Canadian Psychological Association and Hogrefe & 

Huber. 

25 Rockefeller University Press 

Available 3 journals in biomedical research published by Rockefeller 

University Press 

26 Royal Society Available 7 journals published by Royal Society 

27 RSC(Royal Society of Chemistry) 

t provides about 50 titles and news of RSC (Royal Society of 

Chemistry), which is the biggest chemical society in Europe. 

28 SAGE Journals 

Available about 690 journals in all subjects published by SAGE, the 

world’s 5th largest journals publisher 

29 Science(AAAS) 

('22 Upgrade) Available journals include Science published by 

American Association for the Advancement of Science (AAAS) 

30 ScienceDirect 

Available about 2,700 journals in all subjects published by Elsevier, 

the world’s leading STM publisher 

31 SPIE Digital Library 

Available about 10 journals and hundreds of conference 

proceedings in optics and photonics published by SPIE 

32 Springer eJournal 

Provides journal & e-book PDFs in STM(Science, Tech., and 

Medicine) published by Springer 

33 Taylor & Francis Online 

Provide full texts of 2,210 journals of natural science, humanities, 

and social science, etc. 

34 Wiley Online library 

('22 Add 82 journals)  e-journals for all subjects published by 

Wiley 

35 World Scientific e-Journals 

Provide 124 journals issued by World Scientific Publishing 

Company, which is one of the largest publishers in the field of STM 

in the Asia-Pacific region 

 

 Korean Databases 

https://www.jstor.org/
https://www.karger.com/
https://www.nature.com/
https://www.osapublishing.org/
https://www.osapublishing.org/
https://academic.oup.com/
https://www.pnas.org/
https://www.pnas.org/
https://search.proquest.com/psycarticles/socialsciences/fromDatabasesLayer?accountid=27041
https://www.rupress.org/
https://royalsociety.org/journals/
https://pubs.rsc.org/
https://journals.sagepub.com/
https://www.sciencemag.org/
https://www.sciencedirect.com/
https://www.spiedigitallibrary.org/
https://link.springer.com/
https://www.tandfonline.com/
https://onlinelibrary.wiley.com/
https://www.worldscientific.com/
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No. Name Note 

1 DBpia 

Offer domestic journals service from 722 institutions and 1,457 

titles covering all areas 

2 KISS 

KISS provides Korean journals and periodicals published by 1,200 

conferences and research institutes 

3 스콜라 

Providing the original database published by about 360 academic 

journals and academic societies in Korea. 

 

 Reference Manager 

No. Name Note 

1 Endnote 

An article writing support tool that auto-generates a reference list 

in multiple citation styles by organizing academic materials, related 

files, images, such as journal articles, conference papers, 

dissertations, etc. 

(How to Use) Download the installation file from the notice on the 

student bulletin board(Search for "EndNote" 

2 Mendeley 

Research collaboration on social networking service, support 

reference Management, provide discovery Search for documents, 

authors, and research groups 

 

 Magazines 

 

 Others 

No

. 
Name Note 

1 Alloys Phase Diagram 

Fully searchable online database, which contains over 40,300 

binary and ternary phase diagrams and associated phase data 

2 ARTSTOR 

Artstor is the most extensive image resource for educational and 

scholarly use. 

3 ASTM Standards 

American Society for Testing and Materials provides information 

about 450 standard associations around the world, including 

industries, criteria, standards, and other technical resource 

standards. 

(Off-Campus Access) Sign up in campus > URL 

Access(https://compass.astm.org) 

No. Name Note 

1 PressReader 

Provides up-to-date information about leading daily newspapers 

and magazines in 100 countries. 

https://www.dbpia.co.kr/
https://kiss.kstudy.com/
http://scholar.dkyobobook.co.kr/
https://ecm.dgist.ac.kr/s/potal_board/_0014/viewBbs.do?NOTIWR_NO=119799
https://www.mendeley.com/groups/7987841/daegu-gyeongbuk-institute-of-science-and-technology-dgist/
https://matdata.asminternational.org/apd/
https://library.artstor.org/#/
https://compass.astm.org/
https://www.pressreader.com/catalog
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4 
CSD(The Cambridge Structural 

Database) 

The world’s repository for small-molecule organic and metal-

organic crystal structures by CCDC. 

(How to Use) 1) Register 2) Confirm your account(by email) 3) 

Activate license(Activation Key: refer to the manual) 

5 EMIS Analysis report aggregator DB of industry, economy, company, etc. 

6 Grammarly 

('22 New) Writing tool that helps you write clear, flawless text. 

(이용방법) Go to https://www.grammarly.com/enterprise/signup, 

sign up with DGIST email address(@dgist.ac.kr), and check the 

confirm email. > Click the 'Activation Link' button. > Enter the 

Access Code: XYrWhyanoPVUzpBA 

7 HSTalks(Henry Stewart Talks) 

Provide over 1,400 data of seminar presentation from leading 

experts in medicine and life science 

8 IUPAC Standards Online 

(Trial) Online database that provides standards and 

recommendations for chemistry and chemistry-related fields by the 

International Union for Pure and Applied Chemistry (IUPAC) 

9 
JoVE(Journal of Visualized 

Experiments) 

('22 Add 14 journals) Provide video tutorials on experiment, which 

is a peer-reviewed Pubmed indexed journal in the fields of life 

science/medicine/physics/chemistry 

10 MedDRA 

('22 New) MedDRA is designed for use in the registration, 

documentation and safety monitoring of medicinal products 

through all phases of the development cycle (i.e., from clinical 

trials to post-marketing surveillance). 

11 Naxos Music Library 

Naxos Music Library is the world's largest online classical music 

library (available on Ios & Android). 

12 PQDT Global 

ProQuest Dissertations & Theses Global provides 4,120,000 

(abstract) of master’s and doctoral theses from North America 

(U.S.), China, and parts of Europe. 

13 ProQuest Central 

A database covering all scholarly areas(Provides over 9,000 

periodicals, 40,000 international theses (PDF), 900 foreign 

newspapers and country reports, industry reports, etc.) 

14 SAE Digital Library 

Provide data over the internet published by SAE, including technical 

papers, standards, journals, etc. 

15 SciFinderⁿ Academic 

SciFinder is a research discovery tool that allows you to explore the 

CAS databases containing literature from many scientific disciplines 

including biomedical sciences, chemistry, engineering, materials 

science, agricultural science, and more. 

16 SERI&U 지식도서관 

('22 New) A database that provides video content created by the 

Samsung Economic Research Institute under the theme of industry, 

technology, management, and humanities. 

https://www.ccdc.cam.ac.uk/structures/
https://www.ccdc.cam.ac.uk/structures/
https://library.dgist.ac.kr/eData/webdb.do?kwrdBegin=&kwrdEnd=&gubun=alphabet&searchOptn=&themaTy=&mtrilTy=&searchCND=2&webdbNo=&radioMode=prefix&searchSe=ALL&searchKwrd=emis&_csrf=4f3c5d95-f91e-4a71-b3bf-c1f3808da9fd
https://www.grammarly.com/edu
https://hstalks.com/biosci/
https://www.degruyter.com/database/iupac/html
https://www.jove.com/
https://www.jove.com/
https://www.meddra.org/
https://dgist.nml3.naxosmusiclibrary.com/
https://search.proquest.com/pqdtglobal
https://search.proquest.com/
https://saemobilus.sae.org/
https://scifinder-n.cas.org/
http://library.serinu.co.kr/msLoginBridge.html?p_id=dgist
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17 Springer Materials 

Comprehensive database for identifying material properties, which 

covers data from materials science, physics, physical and inorganic 

chemistry, engineering, and other related fields. 

18 Springer Protocols 

Includes 40,000 protocols in 15 subject areas as a manual on basic 

medicine and life science experimental methods and procedures 

19 Statista 

('22 New) Statista is a database of over 1 million statistics and 

reports from over 170 industries. 

(How to Use) Be sure to sign up using the DGIST e-

mail(@dgist.ac.kr) 

20 UpToDate 

It helps Clinical Decision Support System organize the latest 

medical information by EBM clinical practice recommendations and 

includes over 400,000 references, 5,600 drug information, and 

drug interaction, and 30,000 graphics.(for 10 users) 

(How to Use) Email to library@dgist.ac.kr 

21 WIPS ON 

Patent database which includes bibliographic information and full 

text of patents registered in Korea, U.S., Japan, Europe, PCT, etc. 

22 해커스 영어 온라인 강의 

Hackers' online English courses such as TOEIC, TOEFL, TEPS, 

IELTS, and Speaking are provided. 

 

 e-Books 

No. Name Note 

1 AccessBiomedical Science 

('22 New) AccessBiomedicalScience provides a singular source of 

exclusive content that meets the diverse needs of the growing 

biomedical science fields. 

2 ACS In Focus 

A series of e-books published by ACS(American Chemical Society) 

that provide an introduction to an emerging topic area. 

3 ACS Symposium Series 

('22 New) American Chemical Society provides e-books on 

Chemistry. (Agriculture and food chemistry, Cellulose and 

renewable materials, Chemical education, Organic chemistry, 

Polymer chemistry, Materials etc.) 

4 Pearson eTextbook 

(~'22.8.31.) Online DGIST lecture materials from Pearson 

Publishing's eTextbooks 

(How to Use) 3 books per person, up to 3 people per book for 14 

days 

※ After creating an account with DGIST e-mail(@dgist.ac.kr), you 

can borrow textbooks from the "Explore" tab. 

※ 44 e-Textbooks available until August 31, 2022 

5 
PQ Ebook Central Academic 

Complete 

Provide e-books in all subject areas of various universities and 

major publishers 

http://materials.springer.com/
https://experiments.springernature.com/sources/springer-protocols
https://www.statista.com/
https://www.uptodate.com/contents/search
https://www.wipson.com/
https://library.dgist.ac.kr/eData/webdb.do?kwrdBegin=&kwrdEnd=&gubun=alphabet&searchOptn=&themaTy=&mtrilTy=&searchCND=1&webdbNo=&radioMode=keyword&searchSe=ALL&searchKwrd=%ED%95%B4%EC%BB%A4%EC%8A%A4&_csrf=4f3c5d95-f91e-4a71-b3bf-c1f3808da9fd
https://accessbiomedicalscience.mhmedical.com/
https://pubs.acs.org/series/infocus
https://pubs.acs.org/series/symposium
https://bookshelf.vitalsource.com/
https://ebookcentral.proquest.com/lib/dgist-ebooks/home.action?ebraryDocId=null
https://ebookcentral.proquest.com/lib/dgist-ebooks/home.action?ebraryDocId=null
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6 ScienceDirect Book Series 

Provides the latest ebook texts in all subject fields published by 

Elsevier Available with journal content through ScienceDirect 

platform 

7 
ScienceDirect eBook Freedom 

Collection 

Titles are added/deleted every month 

8 Springer STM eBook 

Provides journal & e-book PDFs in STM(Science, Tech., and 

Medicine) published by Springer 

9 Wiley Digital Textbook 

('22 Add 10 journals) Online textbooks from Wiley.(including 17 

textbooks used in the 2021 DGIST lectures) 

(How to Use) Up to 5 people can borrow at the same time 

10 Wiley Online Books Provides e-books and e-journals for all subjects published by Wiley 

11 Wiley Online Reference Works 

Provides reference books in all fields from major publishers in the 

world for research, teaching, and learning, such as the Wiley ABC 

Series, Wiley-Blackwell Handbooks and Companions, and Survival 

Guides 

12 국내 전자책 ('22 Website Renewal) Provides about 3,000 Korean e-Books. 

https://www.sciencedirect.com/
https://www.sciencedirect.com/
https://www.sciencedirect.com/
https://link.springer.com/
https://wileysgp.ipublishcentral.net/institution-library
https://onlinelibrary.wiley.com/action/showPublications?PubType=book
https://onlinelibrary.wiley.com/action/showPublications?PubType=refWork
http://ebook.dgist.ac.kr/
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	Article Search is a search tool for finding journals, books, full-text articles, etc.
	1. Enter the search terms into the ‘E-RESOURCE’ search box at the center of the Library website main page; you can select Advanced Search options from the results page.
	2. Refine results by date, subject, academic journals, and other options.
	3. View results, and link directly to full text or more details.
	* (tip) You can request an article or book you need if it is not subscribed online by DGIST Library, and we will try to obtain it for you from another library.  Library Website > Service Request > Document Delivery Service
	What is Web of Science?
	Web of Science Core Collection provides cover-to-cover indexing back to 1900 across the world’s highest-quality and most impactful publications. Web of Science provides access to bibliographic information, author abstracts, and cited references from scholarly journals and conference proceedings. A cited reference search enables you to find articles that cite a previously published work.
	Accessing the Web of Science
	Web of Science Core Collection is our premier resource on the Web of Science platform and the world’s original citation index for scientific and scholarly research. A curated collection, Web of Science Core Collection contains over 21,100 peer-reviewed, high-quality scholarly journals published worldwide (including Open Access journals) in over 250 sciences, social sciences, and arts & humanities disciplines. Conference proceedings and book data are also available.
	SCIE(Science Citation Index Expanded)
	Created as SCI in 1964, Science Citation Index Expanded™ now indexes over 9,500 of the world’s most impactful journals across 178 scientific disciplines. More than 53 million records and 1.18 billion cited references date back from 1900 to present.
	Go to Web of Science. And you can see a search box in the middle of the page. To make use of the specific features of each resource you should go directly to that resource by clicking on the arrow and selecting it from the drop-down menu. In most cases, the Core Collection is the best option.
	 (Topic Search) If you select the Topic, you can get more accurate results. A search by topic will search in the title, abstract, and keyword fields of Web of Science records.
	 (Author Search) Enter author names in the format shown in the examples in the search boxes. Web of Science will attempt to auto-complete names based on its records. If you know the ResearcherID, enter this directly.
	 (Search Tools) Operators such as AND, OR, NOT, NEAR, etc. can provide more accurate search results.
	Refine your results
	Focus your search to find top Subject Categories, Publication years and more. Once you have a list of results, you can use the limits options available in the Refine Results bar to the left of the screen to add additional terms to your search or to restrict your search by subject area, document type, publication date, language, etc.
	Analyze Results
	 Use Analyze Results to group and rank records in a result set by extracting data values from a variety of fields. Find the most prevalent authors in a particular field of study or generate a list of institutions ranked by record count based on your search query.
	Create a Citation Report
	The Citation Report feature provides opportunities for advanced citation tracing by analyzing Citing Articles and Times Cited. To get a citation report, click on Citation Report on the right of the search box. If the number of articles exceeds 10,000, the Citation Report button will not be available.
	/
	© 2021 Clarivate. Clarivate and its logo, as well as all other trademarks used herein are trademarks of their respective owners and used under license.
	What is Scopus?
	Scopus is a source-neutral abstract and citation database curated by independent subject matter experts who are recognized leaders in their fields. Scopus puts powerful discovery and analytics tools in the hands of researchers, librarians, research managers, and funders to promote ideas, people, and institutions. Scopus is not a database that provides full-text articles but provides links to access library subscription resources or Open Access materials.
	/
	© 2022, Elsevier. (https://www.elsevier.com/solutions/scopus)
	* (tip) What is a citation database?  A citation gives credit to a source and contains publication information such as author(s), title, and date. Most Scopus citations link to the full-text version of the publication hosted on various publishers' platforms.
	Accessing the Scopus
	(Off-Campus) Library Website > Online Resources > Databases or via proxy server: http://libproxy.dgist.ac.kr/_Lib_Proxy_Url/https//www.scopus.com 
	In Scopus, you can search by Documents, Authors, or Affiliations. When you first access Scopus, by default it is set to carry out a 'Document' search, which will retrieve records containing your search terms in the fields that you specify. You should use this option if you wish to retrieve records for publications on a particular topic, or that meet other search criteria.
	You can also choose to search for 'Authors' or 'Affiliations'. These options are useful if you would like to see a breakdown of publications by a particular author or organization, and other data relating to their publications.
	* (tip) Look for 'Search History' at the bottom of the screen. Your search history is shown bottom of the screen with the options to create RSS feeds and alerts, and save, edit or delete queries. Combine queries from your history by entering the listed search number with Boolean operators.
	Documents Search
	Documents include journal articles, book chapters, conference proceedings, articles in press, and data papers.
	/
	[A] Enter your search terms into the search documents box. [B] You can specify in which fields to search using the drop-down menu. [C] Use the '+Add search field' option to add additional fields. Each new search field is combined using the Boolean operators AND, OR, and NOT. [D] To see a complete list of advanced field codes, select Advanced document search.
	/
	 [A] On a search results page, the options ‘Edit’, ‘Save’, ‘Set alert’ and ‘Set feed’ are available for the query. [B] Sort results by date (default option), cited by, relevance, first author name or source title. [C] These options allow batch processing of all or selected results: export; download as PDF; view citation overview; view citing documents; save to temporary list; view references; bibliography; print; or send results as an email. [D] Click 'View abstract' to display the abstract.  opens the full text on the publisher website, if authorized. Related documents displays referenced works.
	* (tip) Analyze Search Results and View Citation Overview Clicking Analyze search results on a search results page shows the number of documents in your search results broken down by year, source, author, affiliation, country, document type and subject area.
	Author Search
	When you search by authors, you can search by last and/or the first name. You also have the option to search by ORCID ID.
	/
	By searching the author's name or ID, you can check the author's profile, the number of papers, and research results such as Citations and h-index. Click a name in the result list to open the Author profile.
	/
	[A] Use 'Set alert' to receive alerts about new publications. Click 'Potential author matches' to view and group together authors with similar profiles. [B] Click 'View h-Graph' to display the h-index as a graph. Click 'Analyze author output' to visualize their output as graphs. 'Citation overview' analyzes citations of their articles by publication year. [C] You can create an email alert to be notified when Scopus publishes new documents by an author. [D] Click ‘Export all’ to export an author’s document information to a selected file type or reference management tool such as EndNote, Mendeley, etc.
	Affiliations Search
	/
	When you search by affiliation, just type the affiliation's name. The search will begin to auto-populate. 'Affiliations Search' is mainly used with interest by research performance managers and executives. Still, researchers can also use it to understand the current status of institutions when studying abroad or thinking about career paths.
	 Use the ‘Sources’ page to browse the list of all journals, book series, trade publications and conference proceedings available on Scopus. You can search by title, subject area, publisher or ISSN.
	What is Google Scholar?
	Google Scholar is a search engine that provides links to full-text articles to which the University Library System subscribes or to articles made freely available by the publisher. From one place, you can search across many disciplines and sources: articles, theses, books, abstracts and court opinions, from academic publishers, professional societies, online repositories, universities and other websites.
	However, Google is also less careful in what it includes in search results than in more curated subscription-based academic databases such as Scopus and Web of Science -  results can consist of unscholarly documents and articles from predatory journals. So it is worth assessing the credibility of the linked resources through Google Scholar.
	Access   https://scholar.google.com/ 
	- Fast and easy to use, so you may find it easier to get started
	- Supports searching in any language
	- Search vast array of information
	- Searches a wide range of scholarly outputs
	Cons of Google Scholar
	- Coverage is incomplete and variable across disciplines
	- Includes results you won't have access to
	- Cannot do backward citation tracking
	- Not everything in Google Scholar is scholarly – results can include unscholarly documents as well as articles from predatory journals
	Library databases provide a more efficient and effective means to access information. Make good use of your library database to compensate for Google Scholar's weaknesses. Go to the library website(library.dgist.ac.kr) and enter your search term in the 'E-RESOURCE' search box on the main page.
	Adding library link
	You can set up Google Scholar to display "Find it @ DGIST" links to your search results. The "Find it @ DGIST" links in Google Scholar allow you to access the full text of sources through the Library subscriptions or request sources through the Interlibrary Loan service./
	1. Go to Settings at the top of the Google Scholar search screen, then select Library links.
	2. Search for DGIST and select the “Daegu Gyeongbuk Inst Sci Tech – Find it @ DGIST” checkbox.
	3. Make sure this box is checked and click Save.
	Since searching in Google Scholar is as straightforward as searching in Google, it's best to jump right in and try it.
	/
	Advanced Search
	/
	You will have to navigate to the three horizontal lines on the left side of the screen to access Google Scholar's advanced search features. By clicking on the "advanced search" link, a box will pop up with many options that will allow you to refine your search. This advanced search will allow you to sort by specific phrases, authors, and date ranges.
	Search Results
	Let's have a look at the results.
	/
	[A] The first two lines of each result provide the document's title. The second line provides the bibliographic information about the document in order: the author(s), the journal or book it appears in, the year of publication, and the publisher. [B] Sometimes, there will be a PDF or HTML link to the right of a document's title on the search results page. Clicking on that link should take you to the full text of the paper. [C] Below the abstract, you can find some useful links. The first of these is the Cited by link will show other articles that have cited this resource. It is an excellent way to track the more recent research that has referenced this article, and other researchers who cited this document lend greater credibility to it. [D] The Versions link will display other versions of the article or other databases, some of which may offer free access to the article.
	Search Tips
	Although Google Scholar limits each search to a maximum of 1,000 results, it's still too much to explore, and you need an effective way of locating the relevant articles.
	 Use only the important words rather than a full sentence or question. Too many words will limit your results.
	 Use double quotation marks for exact phrases. Only use this if you're looking for a very precise word or phrase, because otherwise you could be excluding helpful results by mistake.
	 Place a negative sign (-) in front of words you wish to be excluded from your search.
	 Add the year to the search phrase to get articles published in a particular year.
	Use the filters in the left sidebar. You can restrict the search results and sort by relevance or date.
	What is JCR?
	Accessing the JCR
	Journal Impact Factor (JIF)
	The Journal Impact Factor (JIF) is defined as citations to the journal in the JCR year to items published in the previous two years, divided by the total number of scholarly items, also known as citable items, (these comprise articles and reviews) published in the journal in the previous two years. The JCR year is the last complete year within that year’s JCR data set. For example, the JCR year for the 2021 release is 2020. The JIF is updated around June every year.
	Journal Impact Factor is calculated using the following metrics:
	Browse Journals
	The browse journals page by default lists the top 25 journals by 2020 Journal Impact Factor. To find a specific title and view its profile, use the full search bar for journal name, ISSN, eISSN, category or keyword.
	The browse journal table has customizable indicators divided into four categories for ease of use:
	 Impact Metrics - metrics focused on the citation impact of the journals
	 Normalized Metrics - metrics that have been adjusted mathematically to allow wide comparisons
	 Source Metrics - metrics based on the content of the journals and used as the basis for the Journal Citation Reports
	The Browse Journals table can also be extensively filtered on several criteria using the dynamic filter option. Any applied filters are identified by the green dot next to the filter name. The top 400 items (as sorted) can be downloaded by clicking the Export option in a CSV format. For more extensive data or integration need, consider using the WoS Journals API which provides programmatic access to JCR data.
	/
	© Clarivate (https://jcr.help.clarivate.com)
	Browse Categories
	To help facilitate discovery, you can now browse categories by Groups. The numbers vary by subject area, so impact factors shouldn't be used to compare journals in different fields. For example, the journal with the highest impact factor in the category Applied Physics (2020) was ‘NATURE MATERIALS’ with an impact factor of 43.841; the journal with the highest impact factor in the category Aerospace Engineering (2020) was ‘PROGRESS IN AEROSPACE SCIENCES’ with an impact factor of 8.653.
	(’22 New) Browse Publishers
	The new Browse Publishers feature allows you to search for or browse by publisher to see how many journals are covered in the most recent year.
	What is EndNote?
	Creating, saving and opening a new EndNote Desktop library
	The first step of using EndNote is to create an EndNote Library. Open the EndNote Desktop program. And create a new EndNote Desktop library (File > New) and save it to your preferred location. This will create an .enl file and a .data folder -- both must kept together in the same location for your EndNote Library to work properly. If you move the .enl file to a different location, you MUST move the .data folder with it.
	/
	* (tip) You should only make ONE Library. You can save up to 100,000 references in an EndNote library so that it will be big enough. Don’t make separate libraries for different assignments, etc., as this may lead to conflicts when you start using it with Word.
	Layout
	/
	© 2022 Clarivate.
	Most databases have a direct export feature that automatically transfers your search results into your EndNote library. Every database is different but look for links or buttons within the database that says 'export', 'EndNote', 'send to', or ‘RIS Format'. For some items, you will need to manually enter the information into your EndNote library. 
	Exporting from Google Scholar
	1. Go to https://scholar.google.com 
	2. Click on the 3 line menu at the top left and ‘Settings’
	3. Under Bibliography Manager, click next to ‘Show links to import citations into’ and select EndNote from the Dropdown box.
	4. Click Save.
	/
	Adding References Manually
	 You'll often enjoy automatically capturing new references in your EndNote library without manually populating the information. You also have the option to manually create an entry in your library for any reference materials you can't capture.
	Create a new entry manually by clicking References > New Reference (Ctrl+N) with your EndNote library open.
	/
	© 2022 Clarivate.
	Importing PDF files
	PDF documents can be imported into EndNote. If the reference is already in your library, the PDF will be attached to that reference. If not, a new reference will be created, and the PDF attached.
	1. Open your EndNote library.
	2. Go to 'File' and select 'Import'.
	3. Choose 'File'.
	4. Click the 'Choose...'  button and navigate to, and select, the required file.
	5. Set Import Option to 'PDF', and Duplicates to 'Import All'.
	6. Click 'Import’.
	7. The reference is placed in a temporary group called 'Imported References'.
	* (tip) You can set your preferences in EndNote to enable the automatic importing of PDFs from a designated folder on your computer. When a PDF file is saved in the folder, it is automatically brought into EndNote to create a reference.
	1.  Go to Edit > Preference > PDF handling > PDF Auto Import Folder.
	2.  Select ‘Enable automatic importing’.
	3.  Click ‘Select Folder’, navigate to, and then select the required folder.
	Making Groups to Organize Your References
	 Create Groups in EndNote to organize your references without creating multiple libraries.
	 Create a Group: On the EndNote toolbar, select Groups > Create Group and enter a Name for a group. Highlight references you want to add to the group (use the Ctrl or Shift key to select multiple references. Select Groups > Add References to > Group name or drag and drop references into the group.
	 Create Group Sets to organize your numerous groups: Select Groups > Create Group Set. To add existing groups to the group set, just left click on a group and drag to the group set.
	 Create Smart Groups: 'Smart groups' use search criteria to update groups as existing records are edited dynamically, or new records are added to the Library. Once a smart group is created, it works in the background, automatically adding new records that match the smart group's criteria.
	Find Duplicates
	If you import references from more than one set of results, sometimes duplicate references will be in your library. To identify and delete duplicate records, select ‘Library’ on the toolbar, and click ‘Find Duplicates’. Click Keep this Record for the version required. The other reference will be removed. Check via Preferences (Edit > Preferences > Duplicates) the criteria for deduplicating. 
	'Find Full Text' is a function that matches DOI information, Web of Science URL, and PubMed ID to the collected references to find and automatically attach available PDFs. Select the references in your library that you want to find the full text. Right-click and select ‘Find Full Text’. Under the Library Electronic Resource Use Policy (Library website > Online resources), download less than 30 full texts per day from the same publisher.
	What is CWYW?
	 ‘Cite While Your Write(CWYW)’ is a tool that inserts your EndNote references in a Microsoft Word document. In order to use CWYW, you must have Word installed first in your computer before you install EndNote. DGIST students can access Microsoft Office 365 (easyit.dgist.ac.kr > Software > Microsoft Office 365). After EndNote is installed, the EndNote tab will be displayed in Word.
	/
	Inserting Citation
	 Select the ‘Output Style’ of the journal you want to submit first in Word or EndNote. Position your cursor within your body of text where you'd like to add a citation and then press the 'Insert Citation' shortcut found on the EndNote 20 tab in Microsoft Word.
	* (Output Style) It is a template that tells EndNote how to format the citations in a manuscript or bibliography. The most commonly used output styles are already included in the EndNote 20 download software. You can view these styles on Tools > Output Styles. In Word, go to EndNote20 tab > Style dropdown. Some styles in EndNote may require editing to display correctly in your document. If EndNote doesn't have the style you want, check out the website. (EndNote toolbar ‘Help’ > ‘EndNote Output Styles’)
	/
	© 2022 Clarivate.
	Deleting Citations
	 (Important) Once you have inserted a citation, you should not edit it directly. If you make any changes within the brackets of a citation, it will disappear when the bibliography reformats. Instead, you must use ‘Edit & Manage Citation(s)’ on the EndNote20 tab in Word.
	/
	Converting Citations to plain text
	 If you have completed writing your thesis, you must run the 'Convert to Plain Text' function before submitting it. Because the other person may not have the same version of EndNote, and thus the field codes may not work correctly. To convert your citations to plain text, click ‘Convert Citations and Bibliography’ and save the document. It is recommended to back up in advance because you may post your paper again later in another journal.
	Library Syncing in EndNote 20
	 Try the 'sync' service if you want to use EndNote on multiple devices.
	1. Start configuring library syncing by opening the EndNote library you’d like to designate as your EndNote Sync library and then click Library > Sync.
	2. Click Sign Up to create a new EndNote account or sync with an existing account by inputting your login credentials.
	3. Every 15 minutes, EndNote will check your library to look for changes to send or receive. Click Sync Status to confirm EndNote is synchronizing all reference information between your desktop library and your online account.
	4. To sync on a second or third computer, create a fresh EndNote library by choosing File > New. Click Library > Sync to input your EndNote account credentials and perform your initial sync to copy down all existing library information.
	Library Sharing in EndNote 20
	 Collaboration is essential to your research. The library sharing feature in EndNote 20 allows you to grant access to your designated Sync library by setting up a sharing team with up to 400 other EndNote desktop users. After configuring EndNote Sync, open your designated Sync library and click File > Share to configure your sharing team.
	/
	© 2022 Clarivate.
	What is Mendeley?
	 DGIST Library has subscribed the access to Mendeley Institutional Edition which offers you the following extra benefits in comparison with the free version:
	 100 GB personal storage instead of 2 GB with the 'free account'
	 100 GB shared storage instead of 100 MB with the 'free account'
	 Unlimited private groups of up to 100 collaborators instead of 5 private groups of up to 25 collaborators
	Access to Mendeley Institutional Edition
	Web Importer (ToolBar)
	 If you use 'Mendeley Web Importer', you can save references directly from the website. Download the browser extension Mendeley Web Importer to your browser. The browser extension works with Chrome, and Firefox. When the extension is added, you see it in the upper bar of your browser.
	Importing References from most common databases
	It is best compatible with Scopus and ScienceDirect, another database of Elsevier, a publisher that provides Mendeley. After selecting the desired paper from the search results, click 'Save to Mendeley' to add a reference to Mendeley.
	* (tip) In Google Scholar, references can be imported using 'Web Importer' or in RIS format (RefMan) via the 'Cite(")' feature. 
	/
	Saving PDF files
	 Just drag and drop PDFs into the Mendeley Reference Manager window. Mendeley will automatically extract the metadata from the PDF(s) and create a library entry.
	/
	Copyright © 2022 Mendeley Ltd. All rights reserved.
	Mendeley Reference Manager allows you to annotate and highlight PDFs that are uploaded into your Mendeley library. Don’t forget to click the sync icon at the top right of the screen when you are done reading, highlighting, and annotating. It will save your changes to the cloud so you can see them on any of your devices.
	Mendeley Cite add-in for Microsoft Word allows you to easily insert references from your Mendeley library into your Word document, change your citation style and generate a bibliography - all without leaving your document. It is similar to 'CWYW' in EndNote.
	Groups allow you to share the full text of PDF documents you add to the group. This allows other group members to look at exactly the same documents as you - useful when working together on a project. To create a group, click on ‘New Group’ under ‘Private Groups’ in the left-hand pane.
	What is a Researcher Profile?
	Researcher profiles are kinds of social networks that display research results. It is used to identify individual researchers and collect research results on a single page to communicate with fellow researchers and promote the citing, recruitment, etc. Do you want to effectively publicize your research interests and achievements amid the flood of research literature? Start checking the record of your papers at researcher profiles in primary index DBs such as Web of Science, Scopus, and Google Scholar. In addition, it is good to sign up the popular services, such as ORCiD, ResearchGate, Linkedin, etc.
	How to Search and Make Researcher Profiles
	Publishing in Open Access Journals
	Publishers usually own the copyright of papers. So even if you are an author, it is impossible to share them on your lab website. Not every researcher can get support from the library that has a subscription to as many journals as DGIST. If you want your papers to be read and cited by more researchers, you can consider publishing Open Access. However, OA publication is more expensive for authors because they have to pay the APC(Article Processing Charges).
	Share pre/post-prints on the DGIST Scholar
	However, some publishers allow sharing of preprints or post-prints so that you can archive them on the DGIST Scholar, personal website, or laboratory website following the copyright policy.
	 Open Access Journal List: https://doaj.org 
	 Check the journal copyright policy: https://v2.sherpa.ac.uk/romeo
	Library Libguides
	 DGIST Scholar: https://libguides.dgist.ac.kr/OpenAccess/DGISTScholar
	 OpenAccess@DGIST: https://libguides.dgist.ac.kr/OpenAccess
	STAR Library is a cooperative network in which libraries of four science and technology specialized universities, DGIST, KAIST, GIST, and UNIST, share research information and resources.
	Access   https://starlibrary.org 
	About Services
	 Search for and browse researchers, laboratories & research output of DGIST, KAIST, GIST, UNIST
	 Provide article analysis, citation statistics, and research collaboration information
	 Resource Sharing: Inter Library Loan, Document Delivery Service
	/
	/

